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Chapter 1

OctaMED

1.1 Help Contents (revision 1.51 for OctaMED V6. demo)

(NOTE1l: This help system assumes that you’ve read the printed instructions!)

(NOTE2: This is a *veryx shortened guide version for the non-save Demo )
Welcome to the OctaMED help system. The following topics are available:
Menus
Windows
Main screen
Player commands
Keyboard shortcuts Commodore-Amiga Copyright
Special purpose topics
* Click on any boxed text to see more information on that subject.

* Use the up and down arrow keys to reveal more of a topic.

+ For more detailed information on using this help file, press the "Help"
key.

1.2 Commodore-Amiga Copyright notice

Amiga Workbench is a registered trade mark of Commodore-Amiga inc.

(c) Copyright 1985 - 1992 Commodore-Amiga, inc. All Rights Reserved.

"Amiga/Workbench/Kickstart are registered trademarks. Commodore-Amiga,inc."

(Files from WB 2.1 "TM" are distributed under licence from Commodore) .

They may not be copied and sold without obtaining a licence from Commodore.

1.3 OctaMED Menus
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The OctaMED menu bar contains the following menus:
Project Display Song Block Track

Instr Edit MIDI Settings

1.4 The Project Menu

New Opens the New Project window to discard the current project and
begin a new one.

Open Displays a file requester to load a new song into memory. The
current song will be discarded. If the current project has been
changed since last saving, a requester will offer to save it first.

When loading songs without instruments, a requester will appear if
an instrument can’t be located on disk, offering to continue
loading the other instruments or to stop loading the song
altogether. If you continue until the song is loaded, OctaMED will
load the instruments it can find and put the names of the
instruments it can’t find in their proper numbered places. You must
then locate and load appropriate instruments into these positions;
otherwise, the notes played by those instruments will be silent.

Note that although you can load normal Tracker modules, you can’t
load packed Tracker modules. Tracker player commands will be
converted to the OctaMED equivalent.

If a song isn’t identified as any format listed in the

Save Options window, a requester will offer to try loading the file
as an old Soundtracker song. If it IS an old Soundtracker song it
should load correctly, but if not OctaMED may crash.

Upon successful loading, the song’s annotation text (if any) is
displayed on the title bar: see Song menu —-> Set Annotation.

Save Opens the Save Options window to save the current project on to
disk.
Save Timer Opens the Save Timer window, providing an option similar to

the "automatic save" function in many wordprocessors.
Delete Files Displays a file requester to delete one or more files from
disk (after confirmation). WARNING: THE FILES WILL BE
PERMANENTLY ERASED FROM DISK!

Print Opens the Print Options window, where you may print the current
song in various ways.

Last Message Displays the last message (error or information) appearing
on the screen’s title bar.

Online help Opens OctaMED’s help system (you’re using it now!).
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About Displays information about OctaMED.

Command Shell Opens a Shell-like window for entering OctaMED’s ARexx

*NEW~* commands. Close the window by typing "bye", by pressing
Ctrl-\ or by clicking the close gadget as usual. (See %%
for more ARexx information).

Audio Channels Switch this off to temporarily free the audio channels.

*NEW* This will allow you to use other music programs that need
these channels. When you’ve finished with the programs,
switch this back on (trying to play any instrument will
automatically switch this back on, if possible).

Quit OctaMED Quits the program. Will display a confirmation requester if
the current project has been changed since last saving.

1.5 The Display Menu

Tracker Editor Re-opens the Tracker editor (if it’s been closed).
Main Control Opens the Main Control window.

Information Window Opens the Information window.

Tempo Window Opens the Tempo window.

Synth Editor Opens the Synthetic Sound Editor window.

Sample Editor Opens the Sample Editor window.

Sample List Editor Opens the Sample List Editor window.

MIDI Message Editor Opens the MIDI Message Editor window.

Input Map Editor Opens the Input Map Editor window.

1.6 The Song Menu

Select Opens the Song Selector window, with which you may select the
current song (of a multi-module).

[ Keyboard shortcut: Left Alt-G with Information window active ]
Add New Adds a new song after the last song.
[ Keyboard shortcut: Shift-Ctrl-NK) ]

Delete Last Deletes the last song of a multi-module. Has no effect if
there is only one song in memory.

[ Keyboard shortcut: Shift-Ctrl-NK( ]
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Playing Sequence Opens the Playing Sequence window.
[ Keyboard shortcut: Left Alt-Q with Info win active ]
Section List Opens the Section List window.
[ Keyboard shortcut: Left Alt-C with Info window active ]

Set Options Opens the Song Options window. This window contains several

song-specific options.
Set Volumes Opens the Track Volumes window, used to set the volumes of

the song’s tracks.
Set Annotation Opens a window containing a single text box. In this box

you may type in any text up to 70 characters long. This

text will be saved with the song, then displayed on the

title bar when the song is reloaded. Suitable annotation

text is, for example, a copyright message, the composer’s
~ name, or special instructions.

*NEWx You can now attach a whole text file to a song! Create
the file in an external text editor, then click Load File
to load it. Save Text saves the text under a chosen name,
and Discard Text removes the text from memory. The text
is saved with songs. Note that "tab" characters (ASCII
code 9) can’t be used in the text.

1.7 The Block Menu

New —> Insert Inserts a new block at the current block position. OctaMED
will correct the entries in the playing sequence, so the
song isn’t changed. The length and width of the newly-
created block will be taken from the current block.

[ Keyboard shortcut: Ctrl-I ]

New —-> Append Adds a new block after the last block. The length and
width will be taken from the current block.

[ Keyboard shortcut: Ctrl-N ]

New —-> Insert Def As Insert, but uses the built-in default size: 64 lines
of 4 or 8 tracks (8 if 5-8 channel mode is on).

[ Keyboard shortcut: Shift-Ctrl-I ]

New —> Append Def As Append, but again uses the built-in default size.
[ Keyboard shortcut: Shift-Ctrl-N ]

Delete Deletes the block selected by the sub-menu (Current or Last).

OctaMED removes and corrects the appropriate playing sequence
entries. WARNING: There is no confirmation requester!
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Set Properties Opens the Block Properties window, which contains some
block-specific settings.

Block List Opens the Block List window. This window allows easy
block management.

[ Keyboard shortcut: Left Alt-B with Info window active ]

Highlight Opens the Highlight Options window, where you may highlight
the lines in a block in a particular order.

> *NEW* The Copy/Cut/Paste items in the Block, Track and Edit menus <
> now each have their own separate copy buffer. So you can have <
> block, track and range information all stored in memory at once. <

Cut Copies the current block to the copy buffer, and clears the block.
[ Keyboard shortcut: Shift-Alt-X ]
Copy Places a copy of the current block in the copy buffer.
[ Keyboard shortcut: Shift-Alt-C ]
Paste Overwrites the block with the copy buffer’s contents.
[ Keyboard shortcut: Shift-Alt-V ]

Swap w/Buff Swaps the contents of the current block with the contents of
the copy buffer.

[ Keyboard shortcut: Shift-Alt-Z ]

Insert Line Inserts a new line at the cursor position, increasing the
block length by one line.

[ Keyboard shortcut: Shift-Amiga-Backspace ]

Delete Line Deletes the line at the cursor position, reducing the block
length by one line.

[ Keyboard shortcut: Amiga-Backspace ]
Expand/Shrink Opens the Expand/Shrink Block window.

Split At Cursor Splits the current block into two blocks; the current
line becomes the first line of the next block.

[ Keyboard shortcut: Shift-Ctrl-J ]
Join With Next Joins the current block with the following one.

[ Keyboard shortcut: Ctrl-J ]

1.8 The Track Menu
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> *NEWx The Copy/Cut/Paste items in the Block, Track and Edit menus <
> now each have their own separate copy buffer. So you can have <
> block, track and range information all stored in memory at once. <
Cut Copies the current track to the copy buffer, and clears the track.

(The "current track" is the track that the cursor is on).

Copy Places a copy of the current track in the copy buffer.
Paste Overwrites the track with the copy buffer’s contents.
Swap w/Buff Swaps the contents of the current track with the contents of

the copy buffer.

Insert Empty Inserts an empty track. Tracks on the right of the current
track will be shifted right. The number of tracks doesn’t
increase, so the rightmost track will be discarded.

The sub-menu allows you to apply the operation to either
the current block only or the entire song.

[ Keyboard shortcut: Curr. Block = Alt-Shift-Backspace ]

Delete Deletes a track. Tracks on the right of the current track will be
shifted left. The sub-menu allows you to apply the operation to
either the current block only or the entire song.

[ Keyboard shortcut: Curr. Block = Alt-Backspace ]

1.9 The Instr Menu

Set Parameters Opens the Instrument Parameters window, which allows you
to change various instrument parameters.

[ Keyboard shortcut: Left Alt-P with Main Control active]
Type Opens the Instrument Type window.
[ Keyboard shortcut: Left Alt-T with Main Control active ]

Load Instrument (s) Opens a file requester to load instruments into
memory. OctaMED can load any type of instrument
listed in Instrument Type. The instrument is loaded
into the sample slot displayed in Main Control.

If an instrument already exists in that slot, the new
one will replace it.

If the instrument is a sample or synthetic sound, the
title bar displays its size in bytes, in the form

"n [x bytes]" (where n and x are numbers). n is the
number of sample values in the instrument, x is the
actual amount of memory consumed. (These numbers will
be different if a sample is 16-bit or in stereo).
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The number of waveforms used in a synthetic sound
will also be displayed on the title bar.

If more than one instrument is selected, they are
loaded into consecutive sample slots in alphabetical

order.
Load from List Opens the Instrument Load Window.
Save Instrument Opens a file requester to save the current instrument

on to disk. The sub-menu gives you a choice of five
different formats: see Instrument Type for a brief
description of each. Note that loop information is only
saved with IFF 8SVX files. This format cannot be used
with 16-bit or stereo samples.

It’s recommended to use 8SVX for 8-bit samples and AIFF
or MAUD for 16-bit and/or stereo samples. Use WAVE when

exporting samples to PC computers. When saving synthetic

or hybrid sounds, you may choose any format (since they
are saved as none!). For ExtSamples, save as IFF 8SVX.

[ Keyboard shortcuts: IFF = Ctrl-S, Raw = Shift-Ctrl-S

Flush Current Removes the current instrument from memory, frees the
memory used by it, and clears all its parameters.

[ Keyboard shortcut: Ctrl-G ]

Flush All Unused Removes all instruments unused by the current project
(after a confirmation requester). If there are no
unused instruments, no requester appears.

[ Keyboard shortcut: Shift-Ctrl-G ]

Automatic Flush When selected, a requester to flush unused instruments

will appear on pressing the Clear Current button in the

New Project window.

The following two items affect instrument names when loading songs or
instruments.

Add Path Adds the full path of the instrument when loaded. (The "path"

is the disk and directory name, for example: "Samplesl:Bass/").

This is useful when a song including instruments not in your
sample list is saved without its instruments. When the song is
reloaded, the instruments will be loaded using the new full
path names.

Remove Path Usually songs made with Trackers have instrument names which

include the full path. This option removes the paths of the
instruments, so that they can be loaded using the
sample list instead of directly from the appropriate disk.

Both Add and Remove Path may be active at once. In this case, the original
path is removed, the instrument is loaded using the sample list, and the
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path name from the sample list is added.

Note that the maximum length of an instrument name is 40 characters, so
characters at the end of the name may be lost if the path is very long.

Halve Loaded Samples In previous versions, a newly-loaded sample’s
*NEW* volume was automatically halved while in
5-8 channel mode. To prevent the halving, you
needed to hold down Shift while selecting Instr
menu —> Load Instrument etc.

Well, there’s a different method now. When Halve
Loaded Samples is on, loaded samples will be halved
(surprise!). This switch is turned on automatically
when 5-8 channel mode is selected (and off when 4
channel mode selected).

So to prevent the halving in 5-8 channel mode,
select this menu item before loading a sample.

1.10 The Edit Menu

Most items in this menu act on the current range, selected by dragging the
mouse in the Tracker editor. (The button used to drag is defined in the
Mouse Options window) .

> xNEW+ The Copy/Cut/Paste items in the Block, Track and Edit menus <

> now each have their own separate copy buffer. So you can have <

> block, track and range information all stored in memory at once. <
Cut Range Copies the range to the copy buffer, then clears the range.

[ Keyboard shortcut: Ctrl-X ]
Copy Range Places a copy of the range in the copy buffer.
[ Keyboard shortcut: Ctrl-C ]

Paste Range Transfers the copy buffer to the Tracker editor at the
cursor position, overwriting any existing data.

[ Keyboard shortcut: Ctrl-V ]

Paste To Selected As Paste Range, but inserts consecutive tracks in the
Tracks copy buffer to consecutive selected tracks in the
block.

For example, imagine that the copy buffer contains 3
tracks, the cursor is on track 2, and tracks 2, 5 and
8 are selected. Choosing Paste to Sel Tracks pastes
the copy buffer to tracks 2, 5 and 8 (instead of 2, 3
and 4 as with Paste Range above).

Tracks in the block are selected by clicking their S
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buttons in the Tracker editor.
[ Keyboard shortcut: Shift-Ctrl-V ]
Erase Range Clears the notes in the range.
[ Keyboard shortcut: Ctrl-7 ]

Discard Copy Buffers Flushes all three copy buffers and frees the memory
they occupied.

Transpose Opens the Transpose window, which allows transposing and
changing of notes, and changing of instrument numbers.

Range Current Track Ranges the whole of the track the cursor is on.
[ Keyboard shortcut: Ctrl-B ]

Range Current Block Ranges the whole of the current block.
[ Keyboard shortcut: Shift-Ctrl-B ]

Spread Notes Opens the Spread Notes window, which allows spreading of
the notes in the range across consecutive tracks to the
right of the range.

Pitch Slide Creates a pitch slide, starting from the cursor position and
ending at the next note encountered in the current track.

The sub-menus select which sliding command to use (see
Normal Commands), but the better result is usually achieved
using Type 1. (The difference is that type 2 replays the
note after sliding to it, whereas type 1 doesn’t replay the
note) .

[ Keyboard shortcuts: Type 1 = Ctrl-T, 2 = Shift-Ctrl-T ]

Volume Slide Creates a volume slide, with the cursor position between
the starting and ending volume commands (that is, the "0C"
commands: see Normal Commands) .

[ Keyboard shortcut: Ctrl-0 ]

Generic Slide Creates a slide using any type of player command. Position
the cursor somewhere between the starting and ending
commands before selecting this function.

NOTE: If you want to create a volume slide, this command
will do it just as well as the Volume Slide function
above. However, in Decimal Volumes mode the slide will be
created in hexadecimal, which is bound to cause problems.
So for volume slides, use Volume Slide! :7)

One use of Generic Slide is to repeat a single player
command several times throughout a track. Just make the
starting and ending commands identical.
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[ Keyboard shortcut: Shift-Ctrl-0 ]

Note Echo Opens the Note Echo window, which can produce echoes
automatically using the 0C command.

1.11 The MIDI Menu

OctaMED can output notes and some player commands (see MIDI Commands) to
external MIDI devices, by way of a MIDI interface which you should connect
to your Amiga’s serial port. This menu contains the required functions and
settings for MIDI operation.

You also need to set the MIDI channel and preset number of each MIDI
instrument, using the Instrument Parameters window. (This window also
contains the "Suppress NoteOff" gadget used with some MIDI instruments).

You may use MIDI instruments on any track, and you may also mix Amiga
samples and MIDI instruments on the first four tracks.

Note: please refer to your MIDI device’s manual if you come across terms in
this topic that you aren’t sure of.

MIDI Active Activates MIDI when selected. If the serial port is being
used by another program, however, you must quit the other
program before you can use MIDI. When this option is on, an
"M" appears in the Information window’s display box.

Input Active When selected, you may use your MIDI device to enter notes
into the Tracker editor. Edit mode and MIDI Active must be
on. An "I" appears in the display box mentioned above when
this function is active.

You can also use your MIDI device to both enter samples and
perform many editing functions using the input map editor.

Input Channel Opens up the Input Channel window, with which you may set
the MIDI input channel.

Ext Sync and "Synchronization” (or "sync" for short) involves OctaMED
Send Sync sending information which allows MIDI devices to keep in
time with OctaMED.

When "Send Sync" is activated, this information is sent
when you click either Song Play or STOP (note that it isn’t
sent with Song Cont, Block Play or Block Cont).

When "Ext Sync" is activated, OctaMED can be synchronized
"externally", meaning that an external MIDI device sends
the sync information instead of OctaMED. As well as (of
course) "MIDI Active", "Input Active" must be selected for
Ext Sync to work.

Send Active Sensing After "MIDI Active" has been selected, OctaMED
periodically sends "active sensing" (SFE) messages
when this is turned on. These messages tell OctaMED
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whether all required MIDI leads are properly
connected.

Send Out Input When activated, OctaMED replays input MIDI notes. Useful
for owners of a separate sound module and keyboard.

Read Key-Up’s When switched on, OctaMED records key-up events in the
Tracker editor (as OFFF commands, or 08 hold commands if
the instrument’s hold value isn’t zero).

This switch actually works with normal Amiga keyboard

input. Enter notes while the block is playing: OFFF or 08
commands will be inserted at the points where you release
keys (after holding them down). Chord mode works well too.

Read Volume If you have a touch-sensitive keyboard, the volume will be
entered as a set volume player command (0C) when notes are
input (see Normal Commands) .

Reset Pitch/Presets Resets pitchbenders, modulation wheels and presets
on all channels. (OctaMED sends "preset change"
messages for all MIDI channels - but only when an
instrument is next played).

[ Keyboard shortcut: Ctrl-Space ]
Send MIDI Reset Sends a "MIDI Reset" message (SFF).

Send Local Control Sends a "Local Control On / Off" message. When using
a keyboard synthesizer, the local control (when on)
routes the keyboard directly to the internal
synthesizer. In a multi-timbral setup, switch local
control off; otherwise, it’s usually best to keep on.

Note Killing Selects the method for turning off all notes (by clicking
"STOP" or pressing the space bar).

"$SBx 7B 00" sends "All Notes Off" messages for each MIDI
channel, whereas "Note Off Msgs" sends standard "Note Off"
messages for each track.

The former is recommended if your MIDI device supports it,
because it stops all notes, not just those OctaMED triggers.

(Also see the MIDI Message Editor)

1.12 The Settings Menu

Mouse Options Displays the Mouse Options window, which allows you to
change the function of each mouse button when editing.

Keyboard Options Displays the Keyboard Options window, which contains
several parameters concerning using the keyboard when
editing.
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Programmable Keys Opens the Programmable Keys window, where you may edit

the programmable keys (Shift-0-9).

Keyboard Shortcuts Opens the Keyboard Shortcuts window, where you may

*NEW*

edit OctaMED’s keyboard shortcuts.

Screen Allows you to change OctaMED’s screen mode. In the sub-menu,
*NEW* "Screen Mode" opens a screen mode requester (see your Amiga’s
manual for further instructions). "Like WB", when on, forces
OctaMED’s screen to have the same resolution and number of colors
as the Workbench screen.
OctaMED’s screen is now public (name OCTAMED) .

Font Opens the Font window, where you may change the font used in

*NEW* three different areas.

Palette Opens the Palette Window, with which you can alter the screen’s

colors.

Equalizers Opens two different "equalizer" windows. They’re useful as a
quick check to see which track is playing, or to monitor
rhythm.

Miscellaneous Opens the Miscellanenous Options window.

*NEW*

Aura Sampler Opens the Aura Sampler Options window, which contains

Play After

controls for the Aura 16-bit soundcard.

Loading When set, OctaMED automatically starts playing a song
after it is loaded. Useful, for example, when
listening to other people’s songs.

Auto-Freeze Screen When on, this automatically "freezes" the screen

Windows
*NEW*

when the OctaMED screen is not the frontmost. This
frees more processor time for multitasking.

"Snapshotting" a window is storing its current position in
memory. Normally OctaMED remembers any changes you make to
window positions automatically, but Auto-Snapshot switches this
off if needs be.

Using the sub-menu you can snapshot the current window or
snapshot all windows currently open. "Unsnapshot" sets the
current window’s position to default when it’s next re-opened.
"Unsnapshot All" does this for all windows in the program.

Make these window positions permanent using Save Settings. You
can’t snapshot any window which uses a different set of menus
from the usual ones (e.g. Sample Editor, Sample List Editor).

Load Settings Opens a file requester to load a new settings file. The

default name is "PROGDIR:OctaMEDPro.config".

Save Settings Saves the current settings under the name

"PROGDIR:OctaMEDPro.config". OctaMED will attempt to load
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a file of this name on startup.

Save Settings As Opens a file requester to save the settings under a
~ non-default name.

For a list of settings saved with the config file, see The Settings File.

1.13 OctaMED Windows

These are the windows included in OctaMED.

Project menu
New Project
Save Options
PowerPacker Settings
XPK Settings
Save Timer
Print Options

Display menu
Main Control
Information
Tempo
Tempo Operations
Synthetic Sound Editor
Synthsound Volume
Synthsound Stretch
SynthEd Program
Sample Editor
Toccata Capture
Adjust Y
Add Workspace
Change Volume
Change Pitch
Mix
Filter/Boost
Echo
Noise
Chord Creation
Display Settings
Sample List Editor
MIDI Message Editor
Input Map Editor

Song menu

Song Selector

Playing Sequence
Section List

Song Options

Relative Track Volumes
Song Annotation

Block menu
Block Properties
Block List
Highlight Options
Expand/Shrink Block

Instr menu

Instrument Parameters
Instrument Type
Instrument Load Window

Edit menu
Transpose
Spread Notes
Note Echo

MIDI menu

Input Channel

Settings menu

Mouse Options
Keyboard Options
Programmable Keys
Keyboard Shortcuts
Palette Window

Font

Miscellaneous Options
Aura Sampler Options
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1.14 The New Project Window [ Keyboard shortcut: Amiga-N ]

With this window you can discard the current project and begin a new one.
Open it using the Project menu.

If the current project has been changed since last saving, the window’s

title bar will display "WARNING: Current project modified!". This is the

only warning you are given: no confirmation requesters are displayed.

The three buttons are:

Clear All Discards all samples and songs.

Clear Current Clears the current song only. If Instr menu —-> Automatic
Flush is selected, a requester to flush unused

instruments will also appear.

Cancel Closes the window, canceling the operation.

1.15 The Save Options Window [ Keyboard shortcut: Amiga-S ]

This window allows you to save the current project on to disk. Open it
using the Project menu.

Type the project’s filename into the text box at the top of the window. If

the box is empty on opening the window, a file requester appears as an
alternative method. The file requester can also be opened by clicking the
small GetFile gadget to the left of the text box.

Miscellaneous section

Save Secondary Data Toggles whether to save "extra" information with the

song: instrument names, line highlighting, block
names, and the song name. Otherwise, only what is
essential to play the song is saved (meaning that
the saved file is slightly smaller).

Create Icon When selected, a Workbench icon file is saved with the song:
a cassette image (designed by Izrael Simila of Iz
Productions, thanks!). The default tool is written as
"OctaMEDPlayer".
Save Instruments Chooses whether the song should be saved together with
its instruments. If not, only the instrument names are
(only applies to saved; when the song is reloaded, the instruments are
MMD2 and MMD1 loaded from your sample disks. This is done either by
modules) using the full path name of each instrument (see

(see Instr menu —-> Add Path), or more commonly by way

of the sample list.

When this gadget is on, instruments unused in the song

won’t be saved. MMDO modules are always saved with
instruments.
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By default, all these check boxes are switched on.

The cycle gadget applies to multi-modules, and selects whether to save all
the songs in the multi-module or only the currently selected song. By
default, all songs are saved.

File Format section
This radio button selects which file format to use when saving. Options
are:

MMD2 (OctaMED V5-V6) The OctaMED V5 - V6 format. Supports multiple playing
sequences (sections), 1 - 64 tracks and *NEWx command
pages. If the song requires either of these features,
MMD2 is selected when the Save Options window is
opened.

MMD1 (OctaMED V3-V6) The V3 - V6 format, so is (of course) compatible with
these versions. MMD1l is selected on opening Save
Options if MMD2 format is not required.

MMDO (MED & OctaMED) The pre-OctaMED V3 format, introduced in MED V2.10.
Files saved with this format lack the following:

2-digit commands (the first digit is always zero)
Notes above D-6 (replaced by a —-|- symbol)
Multiple command pages

Blocks that are NOT 4, 8, 12 or l6-track

Block names

Line highlighting

L S e

==> NOTE: Tracker Module saving removed! <==

SMF Type 0 *NEW=* The Standard MIDI File type 0 format. Use this to
LOAD/SAVE MIDI files.

With MMD1 and MMDO songs, song sections are converted into one long playing
sequence, by ordering the sections in the arrangement defined by the
section list. Songs requiring MMD2 format can be saved almost perfectly
under MMD1 (only song sections aren’t saved, as described above). MMDO
modules are always saved with instruments (even if Save Instruments is
switched off) .

Even most options new in V5 (Loop On check box, ExtSamples, default pitch,
extended MIDI preset) are properly saved under MMD1 and MMDO.

*NEWx In V6, all MMD formats now support text file annotation and
instrument output devices. MMD2 and MMD1 support command pages.

Only MIDI-specific information is saved under SMF Type 0: notes, effect
player commands and SysEx messages. (Also tempo information)

The further down the File Format button you go, the simpler the format
becomes, and therefore the smaller the file produced. So for example, if
you don’t require notes above D-6, block names, line highlighting, song
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sections or two-digit commands to be saved, you should choose the MMDO
format, since it produces a smaller file than either MMD1l or MMD2.

*NEW*x Save as Executable. ( no need to add a player to your music disks )

Compression section

The cycle gadget selects the compression (if any) to use before saving the
module:

No Compression Does not compress the module (default).

PowerPacker Compr. Uses the popular powerpacker.library by Nico Francgois
to compress.

SFCD Compression The Stephan Fuhrmann Compact Density algorithm is used
for compression (requires lh.library).

XPK Compression One of the XPK libraries is used. Requires
*NEW* xpkmaster.library and at least one of XPK’s libraries in
LIBS:Compressors. SQSH.library is particularly well
suited to modules.

*NEW* "Settings" allows you to set PowerPacker and XPK’s options. When XPK
Compression is selected, the XPK Settings window opens; otherwise, the
PowerPacker Settings window opens.

"Calculate Size" calculates the size in bytes of the project if it were
saved using the current status of File Format, Save Secondary Data, Save

Instruments and the multi-module cycle gadget.

*NEW+ "Packed" is like Calculate Size but it works out the compressed size.
Save Saves the song using the above parameters.

*%x OctaMED can emulate the "automatic save" function of many wordprocessors
using the Save Timer window

1.16 The PowerPacker Settings Window *NEW*

Set the PowerPacker compression’s settings using this window, opened
through the Save Options window.

The speed-up buffer can be Large, Medium (default) or Small. The smaller
the buffer, the less memory-consuming but the slower the compression speed.

Efficiency can be Fast, Mediocre, Good, Very Good or Best. The better the
efficiency, the smaller the compressed file but the slower the compression

speed.

"Exit" closes the window.




OctaMED

17 /34

1.17 The XPK Settings Window *NEW*

Select an XPK compressor and adjust its settings using this window, opened
through the Save Options window.

The cycle gadget cycles through all the compressors you have in your
LIBS:Compressors directory. Information is displayed about each one.

"Efficiency" controls the efficiency of the compression. The better the
efficiency, the smaller the compressed file but the slower the speed.

"Password" is unghosted only with encryption compressors.

(See the documentation provided with your copy of XPK for more details)

1.18 The Save Timer Window

This window, opened using the Project menu, emulates the "automatic save"
function of many wordprocessors. You can automatically open the
Save Options window every given number of minutes.

The numeric box contains the time in minutes between subsequent openings
of the Save Options window.

Typing in a number above 0 or *NEWx switching "Active" on enables the save
timer. Typing in 0 or turning Active off disables it (the default).

*NEWx Turning "Open Save Window" off only opens the Save Options window the
first time the time elapses. After this, the song is saved using the
current save settings.

1.19 The Print Options Window [ Keyboard shortcut: Amiga-P ]

This window, opened using the Project menu, allows printing of the song and
various song information.

In V6 you can only print the song as text (the format of the Tracker
editor) : because the notation editor has been removed (temporarily) in this
version, graphics printing has also been removed.

The gadgets are as follows:
Output File Consists of a text box and a GetFile gadget to the left of

the text box. With these you may redirect output to a file
instead of the printer.

Start Block Set the starting and ending block of the printout. You may
End Block type in any valid block numbers.
All Blocks Sets the boxes to the first and last block of the song.

Current Block Sets the boxes to the current block number.
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Print Header Selects whether to print the header before the song
contents. The header consists of a list of instruments and
their parameters, the default tempo, play transpose, track
volumes and the playing sequence(s). It is printed as
ordinary text.

Form Feed Sends a form feed after printing each block.

The remaining cycle gadget selects whether to print as text (default), or
not to print the blocks at all (i.e. only the header, if Print Header is
checked) .

Highlighted lines are printed as bold text.

"Print" prints using the specified options, and "Exit" closes the window.

1.20 The Tempo Window

This window, opened using the Display menu, allows you to set the playing
speed ("tempo").

Two tempo modes can be used: SPD (the default) and BPM.

SPD mode

In this mode, the Tempo slider controls the time between each tick, and the
TPL slider the number of ticks per line. (For an explanation of ticks, see
§8.1 of the printed manual).

The Tempo slider can be 1 - 240. The higher the number, the faster the
speed, and the default is 33. For 4 channel or MIDI songs, values 11 - 240
should be used (1 - 10 can also be used, but they only exist for Sound/
Noise/Protracker compatibility). For 5-8 channel songs, values 1 - 10
should be used; 11 - 240 are equivalent to 10.

The TPL slider can be 1 - 32, and the default is 6. The lower, the faster.
This allows a fairly rough tempo setting (it’s the way the other Trackers
set their tempos). For MIDI use (especially for synchronization), you
should leave this at 6 and adjust the Tempo slider instead. Note that the
TPL slider doesn’t affect the speed of effects, unlike Tempo.

(Note for upgraders to V6: the TPL slider is now in DECIMAL!! Even the
programmer can’t remember why it was in hexadecimal in the first place ;-)

BPM mode

In BPM mode, the Tempo slider controls the number of beats per minute (just
like a metronome). For example, a value of 60 is one beat per second. The
LPB slider controls the number of Lines Per Beat. For example, 8 means that
eight lines are considered as one beat.

In this mode it’s best to leave the TPL slider at 6, otherwise the timing
won’t be accurate. (But this may, in fact, be useful to some users. For
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example, obtain double the normal BPM accuracy by setting TPL to 3).

[ Shortcuts: Ctrl- - (minus) Decrease Tempo
Ctrl- + (plus) Increase Tempo
Shift-Ctrl- - Decrease TPL (or LPB in BPM mode)
Shift-Ctrl- + Increase TPL (or LPB) ]
Others

The right-hand cycle gadget affects the overall tempo. The song plays at

normal speed when NRM, two-thirds speed when at 2/3, and half-speed when at
1/2. This is useful for editing while the song is playing: you can slow the
song down without changing the tempo values, to make entering notes easier.

*NEWx "Slow HQ" is a compatibility switch for songs created with OctaMED
Pro V3 and V4. In these versions, switching High Quality Mode on
slowed the tempo slightly. This check box corrects this, and is
saved with songs.

*NEWx "Edit" opens the Tempo Operations window.

NOTE: It’s possible to make a song which takes up all of the processor
time. It will therefore be impossible to stop it. This shouldn’t happen
accidentally, but it can be done, for example, by filling a block with

notes and setting Tempo to 240 and TPL to 1l... To stop playing, hold both
mouse buttons down for about five or six seconds.

1.21 The Tempo Operations Window *NEW*

This window, opened through the Tempo window, allows conversion between the
various methods of setting the tempo provided in OctaMED.

For example, suppose that your song currently uses SPD tempo, but you
suddenly decide you’d prefer BPM. In previous versions, you would:

a) click on the SPD cycle gadget to change to BPM;

b) adjust the Tempo and LPB sliders until, by trial and error, you find
the original speed of your song.

In V6, all you need do is click on "SPD to BPM". This both changes to BPM
mode AND finds the values of Tempo and BPM closest to the your song’s

original speed.

For example, with a tempo of SPD 32/06 (eight lines per second), clicking
SPD to BPM changes the tempo to BPM 60/08 (also eight lines per second).

The gadgets
Click on one of the four top buttons to convert from:

1) SPD to BPM 2) BPM to SPD 3) 4 to 8-channel 4) 8 to 4-channel

In each case, only the Tempo slider is changed: the TPL slider is not
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affected. So conversion is rather approximate, especially when converting
from 4-channel to 8-channel.

If "Change Commands" is on, all the 0F ("set Tempo slider") player commands
in the song will be altered to reflect the new tempo.

"Insert Tempo Change" enters the current Tempo setting as an OF player
command. (You need not have converted the tempo in order to use this
button) .

"Set Current Tempo As Default" is the one button not to do with conversion.
It stores the current tempo settings in memory - SPD/BPM, Tempo, LPB and
TPL. Now whenever you begin a new song (Project menu -> New), these tempo
settings are recalled. To permanently use the settings as default, select
Settings menu —-> Save Settings.

1.22 The Synthetic Sound Editor

Synthetic sounds (or "synthsounds") are made from simple waveforms, which
can be linked together and have their volume and pitch altered by using a
simple "programming language". This window contains the functions to
construct these sounds, and is opened either by using the Display menu or
by clicking the "Edit" button in the Main Control window.

The main advantage of synthsounds is that they take up far less memory than
normal samples. However, this doesn’t mean that synthsounds are a poor
substitute, especially if you enjoy the sounds produced by analogue
synthesizers and the good old Commodore 64! Synthsounds are particularly
useful when composing in certain styles of music, Acid House and Rave being
notable examples. They also have a 5-octave range, compared to the 3-octave
range of ordinary samples.

If you don’t have an appropriate synthsound for your purposes, the first
step is to design a waveform with the tools found in the Synthetic Sound
Editor. Next, you write a simple program that instructs OctaMED how to use
the waveform you’ve designed. Finally, use the synthsound in your song as
you would any other instrument.

Waveform editing

To set up the Synthetic Sound Editor:

a) Select Display menu -> Synthetic Sound Editor
b) In the window that appears, select Project menu —-> New Synthsound
c) Switch edit mode off

There are two waveform displays. The left-hand waveform is the actual
current instrument, and you may play it from the keyboard. The right-hand
waveform is for temporary editing, and it doubles as a copy buffer. Either
of the waveforms can be activated by clicking on them, and the current
waveform appears to "go into" the screen. Initially the right waveform is
active.
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The buttons between the displays are mostly used for transferring and
mixing waveforms between displays:

Copy Copies one waveform to the other (in the arrow direction).
< Swap > Exchanges both waveforms.

<Mix Mixes the left waveform to the right waveform.

<Add Like Mix, but it doesn’t produce any average between the

waveforms. If a waveform exceeds the upper limit, the editor
cuts the waveform’s peaks (producing distortion).

UNDO Reverses the effects of the last editing operation.

Program Opens the SynthEd Program window.

Drawing a freehand waveform

One way to create a waveform is to draw it from scratch. Do this by
dragging the left mouse button along a waveform display.

There are four drawing modes, selected by clicking the two Draw Mode cycle
gadgets.

Pixel Draws in pixels (default).

Line Used for drawing straight lines.

Mix Mixes the drawn lines or pixels with the existing data.
Direct Draws without mixing (default).

(The upper cycle gadget also selects Range, with which you can select a
part of the waveform: see "Range operations" below).

The Preset and Project menus

Instead of drawing freehand (which can be inaccurate), some often-needed

basic waveforms are available from the Presets menu. Selecting a waveform
inserts it into the active waveform display. Also in this menu is "Clear

Wave", which clears the active display.

The following items are included in the Project menu:
New Synthsound Clears the whole synthsound (take care...). Also
forces the current instrument to be a synthsound (if

it’s e.g. a sample).

Reset Temp Wave Clears the right-hand ("temporary") waveform and sets
*NEW* its length to 128.

Exit Synth Editor Closes the window.




OctaMED

22/34

Multiple waveforms
You can construct a synthsound from up to 64 different waveforms. Gadgets
for moving between, adding and deleting these waveforms are as follows:

Waveform: 0 $00/000 < > (below the left waveform display)

From left to right: current waveform number in decimal and hex, total
number of waveforms, move to next waveform (Alt-<right>), move to
previous waveform (Alt-<left>). Shift-clicking an arrow gadget moves to
the first or last waveform.

"New Waveform" adds a new waveform after the last waveform.
"New Here" inserts a new waveform at the current waveform position.
"Delete Last" deletes the last waveform.

"Delete Current" deletes the current waveform.

Waveform length

Each synthetic waveform can be any even length between 2 and 128 bytes. The
shorter the waveform, the higher the pitch (the pitch also depends on the
waveform itself). Usually, to make the pitches harmonically compatible with
other instruments, you should use length 2, 4, 8, 16, 32, 64 or 128. The
length can be changed by using the "Length" slider.

Range operations

Some basic editing operations exist that act on the current range. Mark a
range by cycling the upper Draw Mode cycle gadget to "Range", then drag the
left mouse button over a waveform display (as in the Sample Editor). To
range the whole waveform, click "Range All" (middle of window) . Use the
"Range" and "End" numeric boxes at the lower-right of the window to make
small corrections to the range area.

A range of one byte in length is displayed as a single vertical white line.
This is the cursor; some editing operations make use of it. It may be set
either by clicking on a waveform display (with "Range" cycled), or by using
the "Cursor" gadgets (bottom right): from left to right, they move the
cursor to the start, middle and end of the waveform.

The range gadgets are as follows:

Range All Selects the entire current waveform as the range for editing
operations.

Cut (only works on left waveform) Moves the range contents to the
right waveform, and clears the range.

Copy (only works on left waveform) Copies range to right waveform.

Paste Copies right waveform to cursor position on the left waveform.
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Clear Clears the range.

Double "Doubles" the range, making the pitch one octave higher.

Reverse Turns the range backwards.

<</ >> Shifts the ranged data to the left or right.

The Waveform menu

Change Volume Opens the Synthsound Volume window.
Stretch Opens the Synthsound Stretch window.

Start / Do
Transformation Change one waveform to another smoothly, by generating
the intervening waveforms. For example:

1) Create 9 new waveforms by clicking New Waveform nine times

2) Move to waveform 0 (arrow gadgets), and select a pulse wave
(Presets menu)

) Select Waveform menu —-> Start Transformation

) Now move to waveform 9, and select a sine waveform

) Select Waveform menu -> Do Transformation

) Move to waveforms 1 - 8 in turn, and notice the smooth
transition between the pulse and sine waves

(For information on writing synthsound programs, see SynthEd Program)

1.23 The Synthsound Volume Window [ Keyboard shortcut: Amiga-V ]

This allows you to increase / decrease the volume of a selected range, in
the synthetic sound editor. It is opened by selecting "Change Volume" from
the editor’s Waveform menu.

The numeric box contains the percentage of volume change required. For
example, 50 would halve the volume, while 200 would double the wvolume.
Pressing Return while the gadget is active executes the function.

The OK button carries out the operation, the Cancel button aborts it.

1.24 The Synthsound Stretch Window [ Keyboard shortcut: Amiga-S ]

This allows you to stretch a point on the waveform towards another point,
in the synthetic sound editor. It is activated using the editor’s Waveform
menu.

For example: select a sine wave. Then position the cursor at the middle of
the waveform. Now open this window and type the amount of movement into
the numeric box (e.g. 32).




OctaMED 24/ 34

Typing in a negative number stretches the point to the left. Pressing
Return while the gadget is active executes the function.

The OK gadget carries out the operation, the Cancel gadget aborts it.

1.25 The SynthEd Program Window

Note: Please read this section carefully before experimenting, because you
can crash your Amiga with improper use of the synthsound programming
language (as with any other language).

The synthsound programming language is used for controling the volume,
pitch, and order of waveforms in a synthsound. It consists of simple
commands, of which most have a command value. For a full description of
these commands, see Synthetic Sound Language Commands.

Programming uses two sequences of commands and numbers: the volume
sequence, and the waveform sequence. They are displayed in this window,
opened using the synthetic sound editor.

Sequences: Waveform Volume
| |
000 00 40 0O
001 01 END END
002 02
003 03
004 04 (etc.)
| |

Line numbers: Decimal Hexadecimal

1) Both sequences are a maximum of 127 entries long.

2) To scroll around the sequences, use <up> and <down> or the scroll
bar, or use the F6 - F10 keys as in the Tracker editor.

3) Before editing either sequence, switch edit mode on.

4) To enter commands, move the cursor to the leftmost position of
either list (using <left> and <right>), and press the command’s key
(see Synthsound Commands). Inserting a command that requires a value
also inserts a new 00 value.

5) To change command values, position the cursor over the number to be
changed and type in the new wvalue.

The "Insert" gadget (or the Return key) inserts a sequence entry.
The "Delete" gadget (or the Del key) deletes the current entry.
JMP commands are renumbered when entries are inserted or deleted.

The "Transition" gadget creates transitions. For example, consider this
short waveform sequence:
00 00
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line numbers => 01 OF <= waveform sequence
02 END

If you position the cursor at line 01, making sure that edit mode is
on, clicking Transition creates all the numbers between 00 and 0F (01,
02, 03, 04 ... up to OE). This saves a lot of typing!

=========> ALL COMMAND VALUES IN THE SEQUENCES ARE HEXADECIMAL <=========

**x%x I repeat: all values are hexadecimal. Remember this and you’ll be fine!

If you’d rather your computer didn’t crash, read on...
Make sure all loops (repeated sections of program) contain at least one of
the following commands:

WAI, set volume, set waveform (the latter two commands consist of just
a command value)

otherwise the computer would do nothing but execute sequences, and crash.

Execution speed
You can adjust the speed at which each sequence’s entries are handled by
using the Speed sliders. The speeds can be $1 - $F in hex (1 - 15 decimal).

During program execution you can change either speed using the SPD command.
The speed values are in fact the number of ticks between the execution of
each sequence entry. For example, a speed of 4 executes entries every
fourth tick. (See §8.1 in the printed manual for an explanation of ticks)

Jump-triggering player commands

1) Player command OE in songs causes a Jjump to another position in the
waveform sequence. For example, if you wanted to decrease the pitch
after a certain point, you could create this sequence and track part:

Waveform sequence Part of a track (in the Tracker editor)
00 00 <= Set waveform 00 C-2 30000
01 HLT <= STOP -—— 00000
02 CHD <= Jump point -—— 00000
03 01 —-—— 00E02 <= Jump to position 02
04 END -—— 00000 (pitch starts to slide)

Using command JVS, player command OE can affect the volume sequence too.

2) When Hold and Decay is used with synthsounds, the decay value causes a
jump to another position in the volume sequence. In this way, you can
handle decay in any way you wish. For example:

Volume sequence

00 40 <= Set volume $40 (full) [ The decay for this synthsound
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01 HLT <= STOP should be 2. Decay values are
02 CHD <= Decay point saved and loaded with

03 03 synthsounds. ]

04 END

Using the JWS command, Decay can also affect the waveform sequence.

Note that volume-changing player commands (05, 06, 0C, 0D, 1A and 1B) don’t
work with synthsounds. The set volume synthsound command acts like player
command 0C, and the CHU and CHD commands like player command 0D.

Hybrid sounds

Hybrid sounds are normal samples that use the same programming language as
synthsounds. All synthsound commands can be used with hybrid sounds, except
the set waveform command: since there’s only a single waveform, it neither
works nor is necessary. You can add extra synthetic waveforms for use with
the EN1, EN2 and VWF commands if you wish.

To create a hybrid sound: load a sample, select Instr menu —-> Type, click
Hybrid and close the window, then create a synthsound program using the
Synthetic Sound Editor.

And finally...

Don’t worry if you don’t completely understand synthsounds at first glance!
The language used in this section has been necessarily technical, but read
it through again... :)

Anyway, you don’t need to learn any of this information to use synthsounds,
only to design them; and you don’t need to learn even half this information
to design great-sounding synthsounds!

%% If you’d like to examine some example synthsounds, load the SynthSong
song from OctaMED V6 disk %%, and open the Synthetic Sound Editor.

1.26 The Synthetic Sound Language Commands

During this topic, "Keypress:"

command.

refers to the keypress needed to enter each

Commands that can be used in either sequence

1) Command: END Keypress: n/a Name: End sequence

This command marks the end of each sequence, and always exists. You can’t
insert other commands below the END command. Press the Return key while
the cursor is on this command to create a new position at the end of the
sequence.

2) Command: HLT Keypress: H Name: Halt
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HLT has the same effect as the END command, but it can be inserted anywhere
in either sequence (not just at the end). For example:

03 HLT
04 CHD <= other instructions (could be accessed with the JMP
05 02 <= command, for example: see next command)

3) Command: JMP Keypress: J Name: Jump

The JMP command jumps to another position in the sequence in which it
resides. Used to skip sections or to create repeated sections. For example:

05 JMP
06 0A <= Jump forward to line 0OA

4) Command: WAT Keypress: W Name: Wait
Pauses for a specified number of ticks. Can be $01 - S$7F.
03 WAI

04 10 <= Wait for 16 ticks ($10 16 decimal)

5) Command: SPD Keypress: S Name: Set execution speed
Sets the execution speed of the appropriate sequence.
0A SPD

0B 01 <= speed 1 (quickest)

Volume sequence commands

1) Command: n/a Keypress: n/a Name: Set volume

This is the default command (no command name is required: only a value). It
sets the volume of the synthsound, and is like player command 0C. It should
be 00 - 40 in hex as usual. Note that the relative track volumes (Song

menu) cannot be used with synthsounds.

00 20 <= Volume set to $20 (half volume)
01 10 <= Volume set to $10 (quarter volume)

2) Command: CHD Keypress: D Name: Set volume change down speed
3) Command: CHU Keypress: U Name: Set volume change up speed

These two commands set the speed at which the volume changes on each tick.
The volume starts changing directly after the command. To stop the volume
slide, issue the command again with the speed set to 00.

00 CHD <= Decrease the volume...
01 05 <= ...at speed 5
0OA CHD
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0B 00 <= Stop the volume slide (speed = 0)

4) Command: JWS Keypress: Shift-J Name: Jump waveform sequence

Causes a jump in the waveform sequence. This can, for example, trigger a
pitch change at the end of the volume sequence. It’s Jjust like using the
JMP command in the waveform sequence.

04 JWS
05 OF <= Jump to line OF in the waveform sequence
5) Command: ENI1 Keypress: E Name: Once-only volume shape

6) Command: EN2 Keypress: Shift-E Name: Repeating volume shape

These commands allow you to set the synthsound’s volume shape. You draw the
volume shape on the left-hand waveform display, then use the EN1 or EN2
command to set it. So if you’ve drawn the volume shape in waveform 01, use
the following:

10 EN1 <= (Or EN2)
11 01 <= Set volume shape to waveform 01

The further down a point on the volume shape is, the louder the volume.
Consider this volume shape:

o + <== no volume (0)
I\ /|
Left-hand [\ /|
waveform —> | \ / |
display | N/ |
| \/ |
- + <== full volume (64)

In this example, the volume will gradually increase to maximum, then fade
away to nothing. You can change the volume shape’s speed using the SPD
command. The volume is actually set to full (64) before the volume shape
begins (so if the shape starts at no volume, you may hear a small "click").
The volume shape waveform must always be 128 bytes long.

The difference between EN1 and EN2 is that EN1 only plays once (then
stops), whereas EN2 repeats continuously. (The EN is short for "envelope",
which you must admit is a peculiar name for a volume shape... :).

Waveform (and pitch) sequence commands

1) Command: n/a Keypress: n/a Name: Set waveform
This is the default command (no command name is required: only a value). It
is used to indicate the waveform number (starting from 00). One of these

commands (and a "set volume" command in the volume sequence) must always
exist for the synthsound to be heard. Don’t use waveform numbers that are
higher than the actual number of the last waveform.

00 00 <= Play waveform 00
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01 01 <= Play waveform 01
2) Command: CHD Keypress: D Name: Set pitch change down speed
3) Command: CHU Keypress: U Name: Set pitch change up speed
These two commands set the pitch sliding speed. The pitch starts changing
directly after the command. To stop the pitch slide, issue the command
again with the speed set to 00.

00 CHD <= Slide pitch downwards...

01 03 <= ...at speed 3
4) Command: JVS Keypress: Shift-J Name: Jump volume seguence
Causes a jump in the volume sequence, to trigger volume changes after
particular waveform instructions. It’s Jjust like using the JMP command in
the volume sequence.

09 Jvs

0A 00 <= Start the volume sequence from the beginning
5) Command: RES Keypress: R Name: Reset pitch
Resets the pitch of the note to its original pitch (after a pitch slide).
6) Command: ARP Keypress: A Name: Start arpeggio definition

7) Command: ARE Keypress: E Name: End arpeggio definition

With these commands you can produce an arpeggio, much like player command
00 except that you can define more than three pitches. The arpeggio begins

directly after the ARE command (every ARP command must have a corresponding

ARE command) .
For example, to produce a "dominant 7th" chord (e.g. C-2, E-2, G-2, A#2):

03 ARP <= Start arpeggio definition

04 00 <= Pitch 1
05 04 <= Pitch 2 (C-2 -> E-2 = 4 halfsteps)
06 07 <= Pitch 3 (C-2 -> G-2 = 7 halfsteps)

07 0A <= Pitch 4 (C-2 —> A#2 = 10 halfsteps)
08 ARE <= End arpeggio definition

8) Command: VBS Keypress: Shift-v Name: Set vibrato speed
9) Command: VBD Keypress: V Name: Set vibrato depth

These commands are used to produce vibrato, much like player command 04.
Both the speed and the depth can be $01 - $7F. You need to set both speed
and depth before vibrato can occur, and a value of 00 with either command
turns vibrato off.

02 VBD
03 04 <= Depth set to 4
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04 VBS
05 30 <= Speed set to 30

10) Command: VWF Keypress: Shift-Ww Name: Set vibrato waveform

Sets the vibrato shape. It should always be 32 bytes long. Same idea as the
volume shape commands, but this time the further down a point on the
vibrato shape is, the higher the pitch. Note that the shape is actually
played backwards, so use the Range All and Reverse buttons to reverse it.
By default, a sine wave vibrato shape is used.

00 VBD
01 06
02 VBS
03 40
04 VWF
05 04 <= Now uses waveform number 04 as vibrato shape

1.27 The Sample Editor

This window allows you to edit and digitize samples. Open it either by
using the Display menu or by clicking "Edit" in the Main Control window.

Displayed in the window is either the current sample’s waveform, or the
words "No sample loaded" if the current instrument slot is empty.

The scroll bar below the waveform shows the size and position of the
displayed portion of the sample relative to the whole sample. It also
allows you to scroll around the sample (after zooming in) by dragging it.
You can also scroll using the <left> and <right> keys.

*NEWx The scroll bar on the right of the waveform allows magnification of
the display. Drag it upwards to zoom in, downwards to zoom out.

Many operations act on a specific range, which is set by dragging the left
mouse button along the waveform. After selecting the range, you may
re—-adjust the start or end positions by holding down a Shift key while
dragging the left mouse button. *NEWx Operations will act on the whole
sample if the range is one byte long (i.e. Range Start = Range End).

The gadgets above the waveform are as follows:

Display This display box contains the number of bytes currently being
displayed in the waveform. It changes when zooming in or out
(see later).

Buffsize The size of the current sample (waveform buffer). Typing in a
new size brings up a requester, asking whether to clear the
sample or retain the sample already in memory.

One use of retaining the sample is adding extra "workspace" to
the end of a sample, which is useful in some editing operations
(e.g. echoing). By choosing "Clear" you may create a new
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sample, and this is often the first step when digitizing (see
later) .

There need not be a sample in memory in order to enter a new
size. *NEWx There is now no maximum buffer size, but Amiga
samples should be no longer than 131072 bytes to play properly.
(Aura and Toccata samples can be as large as memory allows).

Range Start / The actual byte positions of the start and end of the

End

range. Adjust these positions by typing in new wvalues.

The following gadgets lie below the waveform:

Play Display Plays the current display at the current pitch (see "Pitch"

below) .

Zoom In / Out Magnifies / reduces the sample so you can see more / less

Show All

detail. Repeated clicking takes you deeper into / further
away from the sample. This is essential for accurate
editing. (Also try the zoom slider on the far right)

Restores the whole waveform to view after zooming.

Range Display Ranges the whole display.

Sample< /
>Buffer

Monitor

*NEW*

Digitize

Copies the copy buffer to the sample, or the sample to the
copy buffer. Can be used to implement a simple "undo".
Before trying out a function, a snapshot of the sample

can be made with ">Buffer". If you’re not satisfied with
the outcome of the function, the sample can be restored
with "Sample<".

Opens a black area, displaying the real-time input waveform from
a sampler (connected to the parallel port). The purpose of
Monitor is to make sure the sound is at a volume level that will
not cause distortion in the digitizing process (see Digitize
below). The sound may "crackle" a bit: this is normal (it won’t
crackle when digitizing).

Other programs are temporarily frozen during monitoring, but you
can still move the mouse pointer etc. Click inside the black
area to stop monitoring.

The small gadget at the top left corner of the black area
selects whether input should be accepted from the left or right
channel of a stereo sampler. (If you own a mono sampler, ignore
this gadget) .

If the Aura card is set to Active, the card input is monitored
instead of the parallel port. If Output Device in the
Instrument Type window is set to Toccata, the Toccata Capture
window opens.

Opens the monitoring area. Starts digitizing (also called
"sampling™) if you click inside the black area. Clicking with
the right mouse button cancels the operation.
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During digitizing, the screen blanks and multitasking is
disabled. The sampling stops when the sample buffer (Buffsize)
is full, but it can be interrupted with the right mouse button.

Clicking Digitize when Buffsize is zero sets Buffsize to 131072
bytes (or if not enough memory, to the largest size possible).

If you want to sample from the Aura or Toccata cards, you need
to set the sample type to 16-bit and select Aura or Toccata
Output Device before sampling. You must therefore have a sample
allocated in advance (type a number into Buffsize).

Pitch The numeric box displays the current sampling / playing period,
and the raised box shows the note equivalent to this period
value. The default is 428 (note C-2), but this can be changed by
either entering a value into the numeric box, or holding the
left mouse button on the note box and entering a new note using
the keyboard.

Freehand Allows you to edit the waveform with the mouse. The maximum
display size is 628 bytes, but you may zoom closer if you wish.
In Freehand mode, the Pixel display mode is automatically
selected.

Loop A sample having a loop means that a note you play with the sample
is sustained until it is stopped. This is due to a particular
section of the sample being continually repeated (or "looped"), and
the boundaries of this section are defined by the two "loop
pointers".

These pointers appear as dotted lines over the waveform, and as
small triangles in the rectangle immediately below the waveform.
They mark the start and end of the looped section.

The "Loop" check box is a duplicate of the "Loop On" gadget in the
Instrument Parameters window. Select this gadget to activate the
loop.

Loop Point The loop pointers can be moved in three different ways:

1) Typing in the Repeat and/or Replen value in the
Instrument Parameters window

2) Dragging the small triangles across the waveform
3) Using the Loop Point gadgets

< and > move a loop pointer two bytes to the left or right. *NEWx Shift-
clicking them sets the loop pointer to the start or end of the sample.

<0 and 0> move a loop pointer to the left or right until a zero is
found. For a decent-sounding loop, it ideally needs to start and end at
the same value, which can often be zero (i.e. no volume). So these
buttons are useful in finding good loop points.

The cycle gadget selects whether the < > <0 0> gadgets act on the loop
start (default) or loop end pointer.
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Bear in mind that zooming in allows far more accurate loop positioning.
Also, good loops are often found by looping any repeating waveform
shapes in the sample (called "envelopes").

*NEWx The "S" button and two display boxes refer to stereo and 16-bit
samples. The left-hand display box displays:

1) 8 or 16, showing whether the current sample is 8 or 16-bit
2) Mono if the sample is mono

3) L<>R, L> or R> if the sample is in stereo. L<>R means that both left
and right channels are displayed in the waveform display. L> means
just the left channel is displayed, R> means just the right channel.

With stereo samples, toggle between L<>R / L> / R> using the "S" button.
(Make the sample stereo in Instrument Type). The right-hand display box
displays similar information, but it refers to the copy buffer. (Empty
means the copy buffer is currently empty).

When entering notes with stereo samples, the left channel is played on

tracks 0 and 3, and the right channel on 1 and 2. So to play both channels
of a stereo sample at once, enter the same note on e.g. tracks 0 and 1.

The following gadgets act on the currently selected range (see above):

Show Magnifies the range to fill the whole display.

Play Plays the range at the current pitch.

Cut Deletes the range and moves it to the copy buffer.

Erase Deletes the range (without moving it to the copy buffer).

Clear Clears the range.

Copy Copies the range to the copy buffer.

Paste Inserts the copy buffer’s contents at the start of the range. The

sample size will increase by the number of bytes inserted.

Reverse Reverses the range left to right. Useful for interpreting hidden
messages in a few rock songs ;)

The menus attached to this window are as follows:

Project

Flush Sample Removes the current instrument from memory.

Load Sample Opens a file requester to load a sample.

Save As... Each of these five items save the current sample in a

unique format (by way of a file requester). See the
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Exit Sample
Editor

Instrument Type window for more information on the formats.

Closes the sample editor window.

With this menu you may edit the sample.

The Cut, Copy,

Paste, Erase, Clear and Reverse items are equivalent to

their Range gadget namesakes.

Paste *xNEWx
(Overwrite)

Erase To Start
*NEW+ / End

Invert

Chop

Remove Unused
Space
Adjust Y *NEW=*

Centralize
*NEW*

Play Buffer

As Paste except overwrites the existing sample contents,
rather than inserting. The sample’s length is unchanged.

Erases from the sample start to Range End, or from Range
Start to the sample end.

Inverts the range (turns it upside-down). This can be
useful when trying to find a smooth loop or a smooth join

between two waveforms (Freehand also helps this).

Deletes the non-ranged parts of the sample. Only the ranged
portion is left.

Deletes empty space (i.e. of zero or very little volume) on
either side of the waveform. This both saves memory and
keeps the timing in songs precise.

Opens the Adjust Y window.

Centers the range about the white zero line. This allows
e.g. Change Volume to be more accurate.

Plays the
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